
SPECIFIC TOPIC INDEX  
 
This index links to more specific discussion of the privacy aspects of RealNetworks products 
and services. It also provides links to privacy resources on the web and instructions on how 
to use optional features of our products: 
 
General Information 

• Information on RN Cookies and How To Restrict or Disable Cookies in Your Web 
Browser  

• Realnetworks Collection and Use Of IP Addresses 
• How To Set Parental Controls in the RealPlayer 
• Parental Consent To Obtain RN Products and Services 
• RealNetworks Collection and Usage of Web Page Referrals 
• Use of Invisible GIFs, Third Party Relationships and Advertising Servers 
• How To Manage RealPlayer Internet Messaging and Auto-Update Communications 
• Sending and Receiving CD Info - The CDDB2 Database 
• Privacy Resources on the Web 
• Change of Control 
• Download the Full Text Version of This Specific Topic Index in PDF Format 

 
Specific Information About Features of RealNetworks Products 

• RealPlayer And Real Premium Services 
• RealNetworks Use of Global Unique Identifiers (GUIDs) 
• RealOne Player For Macintosh OSX 
• RealPlayer 8 Customer Communications 
• RealJukebox 2 Customer Communications 

 
 

http://www.realnetworks.com/company/privacy/cookies.html
http://www.realnetworks.com/company/privacy/cookies.html
http://www.realnetworks.com/company/privacy/ipaddress.html
http://www.realnetworks.com/company/privacy/controls.html
http://www.realnetworks.com/company/privacy/consent.html
http://www.realnetworks.com/company/privacy/urls.html
http://www.realnetworks.com/company/privacy/relationships.html
http://www.realnetworks.com/company/privacy/realoneim.html
http://www.realnetworks.com/company/privacy/cdinfo.html
http://www.realnetworks.com/company/privacy/resources.html
http://www.realnetworks.com/company/privacy/change.html
http://docs.real.com/docs/company/RealNetworksTopicIndex02-16-2005.pdf
http://www.realnetworks.com/company/privacy/realone.html
http://www.realnetworks.com/company/privacy/guids.html
http://www.realnetworks.com/company/privacy/realone_mac.html
http://www.realnetworks.com/company/privacy/realplayer.html
http://www.realnetworks.com/company/privacy/realjukebox.html
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COOKIES 
 
INFORMATION ON RN COOKIES AND HOW TO RESTRICT OR DISABLE COOKIES IN 
YOUR WEB BROWSER 
 
What is a cookie?  
A “cookie” is a small element of data that a web site like real.com can store on your system. 
It can be used to provide you with a tailored user experience, including secure access to 
premium content and services. RealNetworks uses two types of cookies: browser cookies, 
which are sent to your Internet browser, and RealPlayer cookies, which are sent to the 
version of RealPlayer you are currently using. Both types of cookies store these small pieces 
of data on your machine so we may tailor your experience using our products and visiting 
our web sites. 
 
How does RealNetworks use cookies?  
Like many web and e-commerce sites, RealNetworks uses cookies to “recognize” your 
Internet browsing and RealPlayer software in order to display information that is relevant to 
you and to cache some elements of our web sites and services to improve their 
performance. When you visit any real.com web site and use our products and services, 
RealNetworks cookies are sent to our servers automatically. 
 
Cookies allow you to customize your Real experience so when you return to Real web sites 
your settings are maintained. For example, you can store your favorite radio stations in Real 
Radio so when you return your stations are only one-click away.  
 
RealNetworks uses cookies to better personalize specific pages, content, banners, and 
promotions that you will see when you visit RealNetworks web sites and use RealNetworks 
products and services. We also use cookies to understand traffic patterns on RealNetworks 
web sites so that we can enhance your experience and provide you with more relevant 
information about our products and the content available on our web sites.  
 
In addition, we use cookies to authorize access to certain premium or trial content, 
programming, services or software features. To protect your personal information and to 
keep premium content secure, RealNetworks will generate a unique ID (Security ID) based 
on your computer hardware information. This information is verified each time you attempt 
to play content on real.com web pages and is stored in a browser cookie so that you can 
access premium Web pages and in a RealPlayer cookie so that you can play premium audio 
and video.  
 
We treat any personally identifiable information that may be contained in cookies with the 
same confidentiality as when you purchase something on one of our web sites.  
 
What information does RealNetworks put into user cookies?  
When you download or purchase a product from us, create a user account, sign-in to our 
products and services or visit RealNetworks web sites we may set both browser and 
RealPlayer cookies on your personal computer. These cookies may contain values for:  
 

• Cookie version  
• User name (your encrypted e-mail address)  
• User ID (your numeric representation in the RealNetworks database)  
• Your encrypted name  
• Your location information, including zip or postal code, what country you are in and 

your preferred language  
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• Information about the product you are using, including the products name, type, 
version and build number  

• Each RealNetworks premium service you have purchased, your current service 
status, the premium features the service entitles you to and the service expiration 
date. This may also include your current available downloads and access in 
RealNetworks music products and services, such as the Real Music Store and 
Rhapsody 

• Your RealNetworks content preferences  
• Your age and gender  
• Your connection speed  
• Information on radio stations you have recently played  
• Information on your local radio stations  
• When the cookie was last updated  
• When the cookie is set to expire  
• Your RealPlayer’s Security ID number  

 
Information that we store about you in cookies (such as user name and zip code) is a 
reflection of information that you have provided us during product download, purchase, 
registration and installation. You can view and edit this information by visiting the My 
Account area on Real.com. Editing this data will update information stored in your cookies.  
 
This cookie data is read by RealNetworks for the purposes stated above and is not read by 
third parties. 
 
You can set your browser to notify you when you receive a browser cookie, giving you the 
chance to decide whether or not to accept it. You may also change your RealPlayer cookie 
settings through preferences options in our products.  
 
RealNetworks does not require that you accept cookies, however, some functionality on our 
web sites, our product purchase check-out process, and products and services may be 
impaired if you decline to accept cookies. 
 
Retention of Cookies 
RealNetworks will retain cookies that are set on our web sites, products and services for the 
stated purpose of the applicable content or function. For example, a cookie set to identify a 
user who customizes content for Real Home will be retained as long as the user indicates he 
or she wishes to access such customized content. Cookies that are set as part of 
subscription services will be active for the duration of the subscription. In other cases, 
RealNetworks will retain a cookie to maximize the functionality of serving pages and content 
from our web sites, consistent with this privacy policy. 
 
General Information about Managing Cookies 
A number of privacy organizations publish guides on how to manage or disable web based 
cookies. Some of these specific pages are linked here: 
 

• http://privacy.net/cookies/ 
• http://www.epic.org/privacy/tools.html 
• http://www.eff.org/Privacy/eff_privacy_top_12.html 
• http://www.chami.com/tips/internet/042499I.html 
• http://www.privacyfoundation.org/resources/glossary.asp - Cookie 

 

http://privacy.net/cookies/
http://www.epic.org/privacy/tools.html
http://www.eff.org/Privacy/eff_privacy_top_12.html
http://www.chami.com/tips/internet/042499I.html
http://www.privacyfoundation.org/resources/glossary.asp
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IP ADDRESS  
 
REALNETWORKS COLLECTION AND USE OF IP ADDRESSES  
 
What is an IP address?  
Your computer uses IP addresses every time you are connected to the Internet. Your IP 
address is a number that is used by computers on the network to identify your computer so 
that data (such as the Web pages you request) can be sent to you. Our Web servers 
automatically collect IP addresses. From time to time, RealNetworks may use information 
derived from your IP address to deliver you appropriate products, services and software and 
to prevent fraud. For example, RealNetworks may block the ability to purchase specific Real 
services if we detect an international IP address and we are prohibited from selling that 
specific service outside of the United States.  
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PARENTAL CONTROLS 
 
HOW TO SET PARENTAL CONTROLS IN THE REALPLAYER  
 
RealPlayer users have the ability to set Parental Controls on premium, subscription-only 
content offered through Real services. Parental Controls are disabled by default and require 
a user to access My Account via https://account.real.com/acct/login.html or RealPlayer - 
Help Menu to activate Parental Controls. To set Parental Controls, a RealPlayer user must 
have a valid Real account and create a unique Parental Controls Key. The Parental Controls 
Key will be required when blocked premium content is requested or to adjust Parental 
Control settings. Parental Control settings are accessed via My Account, and allow a user to 
choose the level of control and access for content attributes including sex/nudity, violence 
and language.  
 

Content rating levels are set for each Real premium content partner. Parental Controls do 
not block access to web pages viewed or non-Real subscription content accessed with 

RealPlayer. The rating level settings selected by the user will block any premium content 
that is equal to or higher than the rating selected. RealNetworks has adopted the ICRA 

ratings standard for Internet content. More information on ICRA rating standards is located 
at http://www.rsac.org/decode.html. 

 

https://account.real.com/acct/login.html
http://www.rsac.org/decode.html
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PARENTAL CONSENT 
 
PARENTAL CONSENT TO OBTAIN RN PRODUCTS AND SERVICES 
 
RealNetworks products and services are intended for a general audience. From time to time, 
we may provide access to third party content that may primarily appeal to children under 
the age of thirteen. In such event, RealNetworks will require that the user provide a valid 
credit card number in order to verify the user’s intention to access or subscribe to such 
content. RealNetworks will consider provision of the valid credit card as evidence that a 
parent or guardian has given their consent for such access or subscription.  
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REFERRING URL’S 
 
REALNETWORKS COLLECTION AND USAGE OF WEB PAGE REFERRALS  
 
What is a referer?  
A “referer” is the information passed along by a web browser that references the Web URL 
you linked from to visit our web sites. It is automatically collected by our Web servers. This 
information is collected and used by RealNetworks to understand the web sites referring 
traffic to our download and order pages and to present appropriate content to our potential 
customers. Referer information is tabulated by RealNetworks on an aggregated basis to 
identify general trends and traffic patterns.  
 
From time to time, RealNetworks may enter into agreements with content partners that 
require RealNetworks to count the number of product downloads and/or product sales 
stemming from a referral from a content partner site. This information is collected, used and 
aggregated by RealNetworks to fulfill the reporting requirements of those agreements. This 
information may also be combined with the referer information described above and 
tabulated on an aggregated basis to identify general trends and traffic patterns. At the time 
of product download and/or purchase, information you provide to RealNetworks, including 
personal information and referring URL’s, is collected in our web server logs and customer 
database and is kept strictly confidential and not shared with third parties.  
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ADVERTISING INFORMATION 
 
USE OF INVISIBLE GIFS, THIRD PARTY RELATIONSHIPS AND ADVERTISING 
SERVERS  
 
Use of Invisible Gifs  
Invisible GIF’s (also known as “single pixel tags” or “action tags,” or “web bugs”) may be 
used to assist in delivering cookies on our site relating to third party advertising and 
research services. We use this technology to access your personally identifiable information 
in accordance with the other sections of this privacy policy, and to compile aggregate data. 
This technology is used in our email messages that are delivered by a third party 
advertising service.  This technology transfers your e-mail address to us so that we can 
associate your personally identifiable information with the elements (such as links, 
advertisements or graphics) that you click on a RealNetworks web page.  We also use this 
technology to compile aggregate statistics about our website. Additionally, third party 
advertisers and research services may share aggregated and anonymous site statistics with 
RealNetworks regarding the web traffic patterns of web browsers that visit certain RN sites, 
whether through the use of Invisible GIFs or otherwise. If you are concerned about these 
practices, you may opt out from receiving cookies in your browser or you may visit the URLs 
listed below which direct you to the privacy policy page of RealNetworks’ recent advertising 
service providers and instructs you how to opt out from their cookies or informs you of their 
cookie policy.    
 
Relationships with Third Party Advertising Services  
Advertisements displayed on RealNetworks Web sites or embedded in other media content 
provided by RealNetworks may be delivered via an advertising management service. When 
you view a web page on our web site that contains advertising provided one of our 
advertising management services, the advertising service company may place a cookie on 
or retrieve a cookie from your computer if you have enabled cookies. This cookie may 
uniquely designate your computer/browser, without containing any personally identifying 
information such as your name or e-mail address. RealNetworks does not intentionally 
provide any of your personally identifiable information to the advertising service without 
your permission or informed consent.  
 
RealNetworks uses DoubleClick and other advertising services in order to serve ads on our 
web pages. Third party advertising services recently used by RealNetworks are listed below.  
When you search for specific content on RealNetworks web sites, the search terms may be 
embedded in the “search string” that appears in the URL display window of your web 
browser. Certain advertising services or third party content providers may associate these 
search strings with cookies they set or retrieve from our pages.  
 
While RealNetworks does not have access to cookies set by third parties on your hard drive, 
you may be concerned about the potential practices of advertising management services 
and wish to disable this functionality as follows:  
 
You may opt out from receiving cookies in your browser if you do not wish to receive 
cookies from advertising servers. This is a current list of recent advertising service providers 
to RealNetworks and the URL link to the page of their privacy policy that instructs you how 
to opt out from their cookies or informs you about their cookies policy:  
 

• AlmondNet - http://www.almondnet.com/consumer_opt_out.html 
• Avenue A - http://www.avenuea.com/info/optout.asp 

http://www.almondnet.com/consumer_opt_out.html
http://www.avenuea.com/info/optout.asp
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• DoubleClick - http://www.doubleclick.net/us/corporate/privacy/opt-
out.asp?asp_object_1=& 

• Enliven - http://www.enliven.com/corporate/enliven_opt-out.htm 
• Unicast - http://www.unicast.com/company/privacy.asp (They don’t use cookies but 

cache the ads on your browser, so you just have to “flush your cache” which is not 
as gutteral as it sounds.) 

• Coolsavings.com - http://www.coolsavings.com/ 
• Link4ads.com (also known as 24/7 media) - http://www.sabela.com/privacy.html 

 
Because of the changing nature of our advertising service partners, RealNetworks cannot 
guarantee that the above list is complete. If you have concerns about a specific 
RealNetworks advertising service, please contact us at: 
http://forms.real.com/service/contact/privacy.html.  
 
Information Collected When You Acquire Third Party Products  
From time to time, RealNetworks enters into partnerships with other companies to provide 
you with the opportunity to sample or purchase a product or service that might be of 
interest to you. We also partner with other companies to offer plug-ins, products and 
services that enhance the experience of using a RealPlayer, RealJukebox or other 
RealNetworks product.  
 
If you purchase a product or service developed or owned by another company, 
RealNetworks will seek your informed consent prior to giving that company information you 
provide to us. We will never sell, rent or disclose to third parties our customers’ personally 
identifiable information collected from the distribution of RealNetworks products or gathered 
on a RealNetworks Web site unless we are required to do so by law or receive your advance 
informed consent.  
 
Special Third-Party Relationships  
On occasion, RealNetworks will offer our product users and Web site visitors the opportunity 
to participate in third-party or co-branded promotions, sweepstakes or special programs.  
 
The use of any information provided by a user in entering such a third-party promotion will 
be specified prior to the user providing such information. We will also specify the manner in 
which such information is to be used. If your personal information is to be shared with a 
third party, it will only be done with your prior informed consent.  
 
These relationships will be clearly identified by RealNetworks.  
 
The Privacy Policy or policies governing such third-party promotions and/or co-branded 
programs will be specified.  
 
In addition, RealNetworks offers a variety of “plug-in” products that are compatible with 
certain RealNetworks products such as RealPlayer or RealJukebox. While we endeavor to 
fully research and disclose how such plug-ins utilize personal information, RealNetworks is 
not responsible for the operation of plug-ins provided by third parties and we strongly 
encourage you to visit their Web sites and read the privacy policies that govern their usage. 
RealNetworks will not provide personally identifiable information to our product plug-in 
partners without first obtaining the informed consent of our users. 
 

http://www.doubleclick.net/us/corporate/privacy/opt-out.asp?asp_object_1=&
http://www.doubleclick.net/us/corporate/privacy/opt-out.asp?asp_object_1=&
http://www.enliven.com/corporate/enliven_opt-out.htm
http://www.unicast.com/company/privacy.asp
http://www.coolsavings.com/
http://www.sabela.com/privacy.html
http://forms.real.com/service/contact/privacy.html
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REAL INTERNET MESSAGING  
 
HOW TO MANAGE REALPLAYER INTERNET MESSAGING AND AUTO-UPDATE 
COMMUNICATIONS 
 
Scheduler  
An application Scheduler, known as "realsched.exe", is installed along with RealPlayer. Once 
installed, it runs independently of RealPlayer, reminding AutoUpdate, Message Center, and 
the "Watch Folders" feature to perform their tasks at pre-scheduled intervals. The Scheduler 
does not collect personal information or communicate with RealNetworks servers. 
 
In product versions prior to RealPlayer v10, the Scheduler is also used to automatically 
launch RealNetworks Media Type Helper. In such versions, the Media Type Helper ensures 
the system is configured for correct operation of the RealPlayer with Multi-Purpose Internet 
Mail Extensions ("MIME") types, file extensions, Internet protocols, and other media types. 
If a media type has been assigned a different action by a different application, Media Type 
Helper may override the association and substitute its own association consistent with 
RealNetworks policies regarding Ask-Tell-Help. 
 
In RealPlayer v10, RealPlayer launches Media Type Helper at startup. The Scheduler no 
longer invokes Media Type Helper. 
 
You can configure the Scheduler to only launch certain services such as AutoUpdate, 
Message Center, and Media Type Helper by following these steps: 
 

• For RealOne Player v2: on the Tools menu, select "Preferences", "Automatic 
Services", then uncheck the services you want activated only while RealPlayer is 
running. 

• For RealPlayer v10: on the Tools menu, select "Preferences", "Automatic Services", 
"Configure Message Center", then uncheck "Check for new messages" to turn off 
Message Center and Auto-Update communications.  
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CD INFO 
 
SENDING AND RECEIVING CD INFO - THE CDDB2 DATABASE  
 
The CD Lookup feature allows you to automatically obtain detailed information (Artist, song 
track titles, genre) for the CDs you use with RealPlayer. During a request for CD information 
RealPlayer sends the Table of Contents Code from the CD to a database service in order to 
look up the CD information. RealNetworks does create profiles that match the songs or 
albums you record with RealPlayer with personally identifiable information. You can disable 
this in one of two places.  In earlier versions of the RealPlayer, this feature can be disabled 
by selecting “Tools…Album Info…Hide” or by selecting 
“Tools…Preferences…Connection…Internet Settings and unchecking the box titled “Enable 
HTML Clip Info”. In later versions, you can disable this feature by selecting “View…Album 
Info…Hide” or by selecting ““Tools…Preferences…Connection…Internet / Privacy” and 
unchecking the box titled “Enable HTML Clip Info”. However, you will not be able to 
automatically obtain detailed CD information if the feature is disabled. If you record CDs 
offline, CD Table of Contents (TOC) information will be sent to RealNetworks when you 
establish an online connection. Again, you can disable this feature per the instructions noted 
above.  
 
The Submit CD Info feature allows you to send CD information (Artist, Album, Track, Genre) 
you have edited in RealPlayer to the Gracenote CDDB2 database. The information you 
submit will be stored in the CDDB2 database so that other CDDB2 users will automatically 
get CD information when they insert the same CD into their CD drive. Submit CD 
Information does not contain any personally identifiable information and Submit CD Info will 
only be activated if the user chooses Submit CD Info. The Gracenote CDDB2 database and 
storage of Submit CD Information are governed by Gracenote’s Privacy Policy located at 
http://www.gracenote.com/cddb2info/privacy.html. 
 

http://www.gracenote.com/cddb2info/privacy.html


-12- 

PRIVACY RESOURCES  
 
PRIVACY RESOURCES ON THE WEB  
 
Privacy is an important topic for Internet users. These organizations and government 
agencies provide information on privacy principles and how software applications interact 
with personal data. 
 

• Online Privacy Alliance - http://www.privacyalliance.org/ 
• TrustE – http://www.truste.org/ 
• BBB Online - http://www.bbbonline.com/ 
• PrivacyFoundation.org - http://www.privacyfoundation.org/ 
• Center for Democracy and Technology - http://www.cdt.org/ 
• Junkbusters - http://www.junkbusters.com/ 
• Privacy Online: Fair Information Practices in the Electronic Marketplace - 

http://www.ftc.gov/reports/privacy2000/privacy2000.pdf 
• Georgetown Internet Privacy Policy Study - 

http://www.msb.edu/faculty/culnanm/gippshome.html 
• Global Internet Liberty Campaign (GILC) - http://www.gilc.org/ 
• Kidz Privacy - http://www.ftc.gov/bcp/conline/edcams/kidzprivacy/ 
• Online Privacy Guide - 

http://www.zdnet.com/products/stories/reviews/0,4161,2245224,00.html 
• Center for Democracy & Technology: Data Privacy - http://www.cdt.org/privacy/ 
• Electronic Privacy Information Center: Privacy - http://www.epic.org/privacy/ 
• Department of Commerce Privacy Questions - 

http://www.ntia.doc.gov/ntiahome/privacy/6_5_98fedreg.htm 
• Federal Trade Commission—Privacy Initiatives - 

http://www.ftc.gov/privacy/index.html 
 

http://www.privacyalliance.org/
http://www.truste.org/
http://www.bbbonline.com/
http://www.privacyfoundation.org/
http://www.cdt.org/
http://www.junkbusters.com/
http://www.ftc.gov/reports/privacy2000/privacy2000.pdf
http://www.msb.edu/faculty/culnanm/gippshome.html
http://www.gilc.org/
http://www.ftc.gov/bcp/conline/edcams/kidzprivacy/
http://www.zdnet.com/products/stories/reviews/0,4161,2245224,00.html
http://www.cdt.org/privacy/
http://www.epic.org/privacy/
http://www.ntia.doc.gov/ntiahome/privacy/6_5_98fedreg.htm
http://www.ftc.gov/privacy/index.html
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CHANGE OF CONTROL  
 
Your personally identifiable information may be transferred in connection with a sale, 
merger, transfer, exchange or other disposition (whether of assets, stock or otherwise) of 
all or a portion of a business of RealNetworks and/or its subsidiaries.  Under the EU Safe 
Harbor, you have the right to opt out of such a transfer.  
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REALPLAYER  
 
REALPLAYER AND REAL PREMIUM SERVICES  
 
RealPlayer allows you to play streaming audio, video and multimedia as well as download, 
play, record and manage digital music. Real premium services are our family of premium 
consumer subscription services.  
 
Customer Communications  
A RealNetworks account is suggested, but not required, to use the free version of 
RealPlayer. RealNetworks will prompt users five times to supply account information. To 
purchase Real premium services or products, a RealNetworks account is required.  
 
The RealPlayer consists of interactive Internet applications that perform a variety of 
communications over the Internet as part of their normal operation. A number of 
communications features are automatic and are enabled by default. For example, when 
RealPlayer, Auto-Update and Message Center communicate with RealNetworks servers, the 
software transmits standard information in order to deliver you the appropriate software, 
content, messages and updates. This includes information about the RealNetworks product 
you have installed (including the products name, version and build number), your current 
operating system, your location information (including zip or postal code, country and your 
preferred language) and standard Internet communication information including IP address, 
browser and date.  
 
Once you Sign-in to RealPlayer and Real during installation, your account name (your 
encrypted e-mail address) and user id will be sent in communications with RealNetworks’ 
servers. These are both used to verify access premium content, non-premium content, 
services, features, AutoUpdate, Message Center and other personalized services. 
RealNetworks may match the account name and user ID to personally identifiable 
information in order to provide you with content, products, services, and software that 
you’re entitled to and to provide you with relevant information.  
 
You may erase personally identifiable information stored on your machine and may stop 
RealPlayer transmitting your user name and user ID to RealNetworks at any time by signing 
out. To sign out, simply select Help, then ‘Sign out of Real.’ If you choose to sign out, you 
will not be able to access any premium Real member benefits, including product features 
and premium content.  
 
A RealNetworks account is suggested, but not required, to use the free version of 
RealPlayer. RealNetworks will prompt users five times to supply account information. To 
purchase Real premium services or products, a RealNetworks account is required.  
 
RealNetworks Content Partner Programs in Real  
From time to time, RealNetworks will partner with a content provider, media publisher or 
sports league to bring you premium content on a subscription basis either as part of a 
RealNetworks aggregated content subscription product (such as SuperPass), or as a stand-
alone subscription offering. In cases where RealNetworks is performing e-commerce 
services for a content partner subscription product, a user will most likely begin the order 
process for the partner’s subscription product on the content partner’s web site, and will link 
to a product order path on pages managed by RealNetworks.  
 
In these cases, RealNetworks handles the information input and credit card processing for 
these content partner subscription products. When a user enters personal information, 
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including name, address and credit card number on the order form, RealNetworks sends this 
information to the respective content partner, whose use of such information will be 
governed by its terms of service and privacy policy. RealNetworks may also retain this data 
and we will apply our Privacy Policy to our use of such data. Where a user has separately 
obtained a RealPlayer for use of a content partner subscription product, information supplied 
to RealNetworks as part of the RealPlayer registration process will be subject to 
RealNetworks Privacy Policy. 
 
Installation and Log-in  
Using RealPlayer for the first time requires a user to complete a brief installation process, 
including signing in if you have created a RealNetworks account. Sign-in also may be 
required periodically during use of Real services and the RealPlayer. Sign-in is required to 
access premium features, content, services and personalization of products and services. 
During the installation information is sent in communications with RealNetworks servers. 
This information may include:  
 

• Your age (optional information submitted by you during installation)  
• Your gender (optional information submitted by you during installation)  
• Your content preferences (optional information submitted by you during installation - 

used to deliver information about products, services, content and special offers you 
may be interested in)  

• Information about the product you are installing, including the product name, version 
and build number 

• Your current operating system  
• Your connection speed  
• Your location information, including zip or postal code, what country you are using 

the product in and your preferred language (used to deliver localized versions of 
services, products and content)  

• Standard Internet communication information including IP address, browser and date  
• Your RealPlayer’s Security ID number.  

 
AutoUpdate  
RealPlayer, using AutoUpdate, automatically communicates with RealNetworks servers on 
the Internet to check for updates to RealNetworks software and RealNetworks partner 
software, such as bug fixes, security and other patches, enhanced functions, plug-ins, and 
new versions.  When contacting RealNetworks servers, AutoUpdate sends information about 
your installed RealNetworks products to determine update availability. The AutoUpdate 
feature is activated by default. 
 
RealPlayer will perform AutoUpdate checks under the following conditions: 
 

• User-initiated – Performed by choosing “Check for Update” from the Tools Menu. 
• Content-initiated – RealPlayer will perform an update check when you attempt to 

play content for which RealPlayer requires additional software to handle. 
• Automatic – This type of update check occurs automatically, and runs in the 

background without advanced notification.   
 
During any AutoUpdate check, additional updates to RealPlayer may be downloaded.  If you 
prefer to be notified by AutoUpdate before downloading software, follow these steps: on the 
Tools menu, select "Preferences", "AutoUpdate", and then de-select "Automatically 
download and install software updates." For additional configuration options, see the section 
below entitled  "Scheduler". 
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RealNetworks recommends you regularly check for updates to keep your RealPlayer 
software up to date by selecting "Check for Update" under the Tools Menu. AutoUpdate will 
request an update when you attempt to playback content for which RealPlayer requires 
additional software to handle. During any software check, AutoUpdate may download 
additional updates to RealPlayer. AutoUpdate also has the capability to run independently of 
the RealPlayer to perform background checks and send information about your installed 
RealNetworks products to determine update availability.  A background update check may 
happen automatically and without advanced notification if RealNetworks deems a critical 
update is required, such as for urgent security patches and bug fixes.    
 
Message Center  
The RealPlayer Software, using Message Center, automatically communicates with 
RealNetworks servers to check for new important messages, including software updates and 
service bulletins. Message Center can also run independently of RealPlayer to perform 
background message checks. Message Center sends information about a user's message 
category preferences as well as installed RealNetworks products and components to the 
servers to determine suitable product update and other messages. The RealPlayer is set by 
default to check for messages once or twice per week, and to display the headline portion of 
such messages when they arrive.  You can change the way Message Center displays 
messages and the frequency with which it checks for new ones by following these steps: On 
the View menu, select "Message Center"; The Message Center appears; within Message 
Center, select "Preferences" (or "Delivery Preferences", in RealOne Player v2 and earlier) 
and set your desired preferences. If you sign up for message topics that send messages 
more frequently than you previously selected, your frequency setting may be adjusted.  For 
additional configuration options, see the following section "Scheduler". 
 
The first time you use RealPlayer, you may be sent a Welcome Message that will enable you 
to opt-out of receiving Special Offers messages and opt-in to receive other personalized 
messages, depending on your categories of interest to accommodate your topic choices.   
 
Scheduler 
An application Scheduler, known as "realsched.exe", is installed along with RealPlayer. Once 
installed, it runs independently of RealPlayer, reminding AutoUpdate, Message Center, and 
the "Watch Folders" feature to perform their tasks at pre-scheduled intervals. The Scheduler 
does not collect personal information or communicate with RealNetworks servers. 
 
In product versions prior to RealPlayer v10, the Scheduler is also used to automatically 
launch RealNetworks Media Type Helper. In such versions, the Media Type Helper ensures 
the system is configured for correct operation of the RealPlayer with Multi-Purpose Internet 
Mail Extensions ("MIME") types, file extensions, Internet protocols, and other media types. 
If a media type has been assigned a different action by a different application, Media Type 
Helper may override the association and substitute its own association consistent with 
RealNetworks policies regarding Ask-Tell-Help. 
 
In RealPlayer v10, RealPlayer launches Media Type Helper at startup. The Scheduler no 
longer invokes Media Type Helper. 
 
In recent product versions, you can configure the Scheduler to only launch certain services 
such as AutoUpdate, Message Center, and Media Type Helper by following these steps: 
 

• For RealOne Player v2: on the Tools menu, select "Preferences", "Automatic 
Services", then uncheck the services you want activated only while RealPlayer is 
running. 
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• For RealPlayer v10: on the Tools menu, select "Preferences", "Automatic Services", 
"Configure Message Center", then uncheck "Check for new messages" to turn off 
Message Center and Auto-Update communications or check "Check only when 
RealPlayer is running" to limit communications only to when RealPlayer is running. 

 
Cookies in Real Web Sites, Services and RealPlayer  
RealPlayer and Real services (including Real Web sites and premium content services) both 
employ the use of browser cookies and RealPlayer cookies. You may disable the 
transmission of RealPlayer cookies from your computer to RealNetworks in RealPlayer by 
selecting “Tools menu…Preferences…Internet Settings…Enable Cookies.” Please note that 
RealPlayer automatically sets RealPlayer cookies, including cookies that control access to 
Real premium features, when the transmission feature is disabled. These cookies are 
enabled by default and cannot be turned off, however no cookie data will be transmitted 
from the user’s machine to RealNetworks.  
 
You may disable browser cookies in RealPlayer by selecting “Tools 
menu…Preferences…Internet Settings…Browser preferences” or by adjusting the privacy 
settings in your Internet browser.  
 
RealPlayer Services  
RealPlayer features a variety of free and premium web services that are displayed in 
RealPlayer as web pages. These services include Search, Radio Tuner, Artist Guide, CD Look 
Up, Topic Centers and Channels.  
 
When you access these services RealPlayer sends relevant system and geographic 
information to display the correct web pages. RealPlayer cookies and browser cookies may 
be sent in communications with RealNetworks’ servers when one of these services is 
accessed.  
 
The CD Lookup feature allows you to automatically obtain detailed information (Artist, song 
track titles, genre) for the CDs you use with RealPlayer. During a request for CD information 
RealPlayer sends the Table of Contents Code from the CD to a database service in order to 
look up the CD information. RealNetworks does create profiles that match the songs or 
albums you record with RealPlayer with personally identifiable information. You can disable 
this in one of two places.  In earlier versions of the RealPlayer, this feature can be disabled 
by selecting “Tools…Album Info…Hide” or by selecting 
“Tools…Preferences…Connection…Internet Settings and unchecking the box titled “Enable 
HTML Clip Info”. In later versions, you can disable this feature by selecting “View…Album 
Info…Hide” or by selecting ““Tools…Preferences…Connection…Internet / Privacy” and 
unchecking the box titled “Enable HTML Clip Info”. However, you will not be able to 
automatically obtain the detailed CD information if the feature is disabled. If you record CDs 
offline, CD Table of Contents (TOC) information will be sent to RealNetworks when you 
establish an online connection. Again, you can disable this feature per the instructions noted 
above.  
 
RealPlayer allows you to automatically look up artist biographies, album art and information 
through the Artist Guide (Album Info) feature. When you use Artist Guide, information 
identifying the currently playing track is transmitted to Real.com and content partners so 
that we can display the appropriate artist information. This information includes Artist 
Name, Track Name, Album Name and Genre. Selecting “View…Album Info…Hide” can disable 
the Artist Guide feature.  
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RealPlayer radio functions include several features that are designed to make it easy to 
access your favorite Internet Radio stations: local stations and recently played stations. The 
local stations feature prepopulates radio stations based on your zip code information. 
Recently Played Stations pre-populates your Radio page with stations you play regularly. To 
bring you these features we store information on your local stations and recently played 
stations in browser cookies on your computer. You may disable these features at any time 
through the Settings link on the Radio page.  
 
Technical Support  
If an error occurs when you are using RealPlayer, a dialog box will appear describing the 
error. When you select the “More Info” button on the dialog box to obtain more information 
about the problem, RealPlayer sends relevant system configuration information to help 
RealNetworks technical support diagnose and resolve the problem. Selecting “Tools menu 
Preferences…Internet Settings…Send Support Info” can disable this feature.  
 
RealPlayer Communications with Streaming Media Servers  
Like previous versions of RealPlayer, RealPlayer must communicate with streaming media 
servers in order to receive the content sent from the servers. Those servers are typically 
owned and operated by third-party content providers, but these servers might also reside at 
RealNetworks if we are providing hosting services for a content provider, or are providing 
content ourselves. This section describes the information transmitted in those 
communications.  
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GUIDS 
 
REALNETWORKS USE OF GLOBAL UNIQUE IDENTIFIERS  
 
What is a GUID?  
A Globally Unique Identifier (GUID) is an alphanumeric identifier used to indicate a unique 
installation of a product, and is found in many popular software applications such as web 
browsers and media players. RealNetworks and third party content providers use GUIDs for 
aggregate statistical analysis, to authenticate premium content and to personalize products 
and services. 
 
In general usage, RealPlayer and RealPlayer 10 GUIDs are disabled by default.  However, 
when accessing content protected by a digital rights management solution (“DRM”), such as 
the downloadable music available in the RealMusic Store or DRM protected content in 
premium content services (both RealNetworks’ and third parties’), the use of GUIDs may be 
required by the DRM solution or content delivery service.  In such cases, GUIDs may be 
used by such software or services in conjunction with the RealPlayer or RealPlayer 10, and 
cannot be disabled by the end user.  GUIDs received by RealNetworks in such cases are 
used for the purposes of content management, authentication, and reporting content access 
and usage data to content providers and rightsholders.  However, RealNetworks’ reports to 
third parties concerning content end user access and usage data are provided in an 
anonymous or aggregated manner; RealNetworks does not provide personal information 
concerning individual end users to third parties as part of such reports.  
  
How to Enable or Disable Transmission of the RealPlayer 10 GUID  
At any time, a user may prevent the RealPlayer from transmitting its GUID to a RealServer 
(except in the context described above). On the menu at the top of the RealPlayer, select 
Tools, then Preferences, then the Connection tab, then Internet/Privacy Settings. Uncheck 
the box titled “Send RealPlayer GUID to RealServers (To aid content providers). You may 
enable the transmission of the GUID at a later time by following the same procedure and re-
checking the box marked “Send RealPlayer GUID to RealServers (To aid content providers).”   
 
How to Enable or Disable Transmission of the RealPlayer GUID  
At any time, a user may prevent the RealPlayer from transmitting its GUID to a RealServer 
(except in the context described above). For RealPlayer 7, on the menu at the top of the 
RealPlayer, select View, then the Preferences tab, then the Support tab. Under the box 
entitled “Supply GUID when playing streaming content” uncheck the box labeled “Send 
RealPlayer GUID to RealServers.” For RealPlayer 8, on the menu at the top of the 
RealPlayer, select View, then Preferences, then the Support tab.  Uncheck the box labeled 
“Send RealPlayer GUID to RealServers.  For the RealOne Player, on the menu at the top of 
the RealPlayer, select Tools, then Preferences, then the Connection tab, then Internet 
Settings.  Uncheck the box entitled “Send RealOne Player GUID to RealServer.”    You may 
enable the transmission of the GUID at a later time by following the same procedure and 
rechecking the appropriate box. 
 
Playing content  
Whenever you play a streaming media clip, RealPlayer must send certain information to 
content broadcasters so that they can send the clip data stream to your computer. This data 
includes your connection speed, player version, language preference, Zip Code and country.  
 
Connection Quality Information  
By default, RealPlayer sends anonymous connection quality data to broadcast servers to 
indicate the quality and bandwidth of the stream that you received while playing a clip. This 
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helps the content provider understand the quality of the streaming media service that they 
are providing to you. Selecting “Tools menu Preferences…Internet Settings…Send 
connection-quality data to RealServers” can disable this feature.  
 
REAL PREMIUM SERVICES MEMBER VERIFICATION  
 
Member Verification  
As a Real Services Member, you enjoy an exclusive combination of premier audio and video 
content, software, and services. Because these benefits are available only to active 
members, we need to personally identify you whenever you attempt to access premium 
member benefits, including content, services and software. We keep a record in your 
member account of any Real software that you download or Real services for which you sign 
up so that we can provide you customer service and technical support and in order to 
prevent fraud.  
 
How Does Real Member Verification Work?  
By default, RealNetworks places a RealPlayer cookie and browser cookie on your computer 
to identify you as a Real Member. This optional cookie allows us to recognize you when you 
attempt to access Real benefits so that you don’t need to enter your e-mail name and 
password each time.  
 
Opting Out of Cookies  
You may elect not to have your membership information stored in a Web browser or 
RealPlayer cookie by adjusting your security settings. However, by doing so you will be 
required to re-enter your e-mail address and password each time that you would like to 
access Real member benefits. Please note that RealPlayer automatically sets RealPlayer 
cookies that control access to Real premium features. These cookies are enabled by default 
and cannot be turned off.   
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REALONE PLAYER FOR MACINTOSH OSX  
 
RealOne Player for Macintosh OS X allows you to play streaming audio, video and 
multimedia. RealOne Player for Macintosh contains a limited set of features compared to 
RealPlayer for Windows. The Macintosh OSX is a beta product from RealNetworks and aside 
from the specific descriptions of features below otherwise contains functions that are more 
fully described in our Privacy Policy.  
 
AutoUpdate  
RealOne Player for Mac, using AutoUpdate, automatically communicates with RealNetworks 
servers on the Internet to check for updates to RealNetworks software and RealNetworks 
partner software, such as bug fixes, patches, enhanced functions, missing plug-ins and new 
versions. When contacting RealNetworks servers, AutoUpdate sends information about your 
installed RealNetworks products and components to determine upgrade availability. 
AutoUpdate also has the capability to run independently of RealOne Player for Mac to 
perform background update checks. RealNetworks may download updates during the 
background checks, when RealOne Player automatically communicates with RealNetworks 
servers, when you manually check for updates, or when RealPlayer detects a file it does not 
support. To manually check if an update is available or turn off background update checks, 
follow these steps: On the RealOne Player menu, choose Preferences and AutoUpdate to 
view installed components and adjust settings. However, as we describe above, certain 
updates to RealOne Player functionality will happen automatically and without advance 
notification.  
 
Cookies in RealOne Player for Mac and Real Services  
RealOne Player for Mac and Real services both employ the use of browser cookies and 
RealOne Player cookies.  
 
You may disable the transmission of RealOne Player cookies from your computer to 
RealNetworks in RealOne Player for Mac by selecting “RealOne Player 
menu…Preferences…Internet Settings…Enable Cookies.” Please note that RealOne Player for 
Mac automatically sets RealOne Player for Mac cookies. These cookies are enabled by 
default and cannot be turned off, however no cookie data will be transmitted from the user’s 
machine to RealNetworks.  
 
You may disable browser cookies in RealOne Player by selecting by adjusting the privacy 
settings in your Internet browser.  
 
Media Type Helper  
The Media Type Helper ensures the system is configured for correct operation of the 
RealOne Player for Mac with Multi-Purpose Internet Mail Extensions (“MIME”) types, file 
extensions, Internet protocols and other media types. If a media type has been assigned a 
different action by a different application, Media Type Helper may override the association 
and substitute its own association consistent with RealNetworks policies regarding Ask-Tell-
Help.  
 
Media Type Helper notifies you that an application has overridden your default settings only 
when your RealOne Player for Mac is currently open and running. You have the option of 
selecting the “More Info” button in order to learn more. If you select “More Info”, 
information on the file type (e.g., .MP3) and overriding application is sent to RealNetworks. 
The purpose of sending this information is to display a web page to inform you about the file 
type and overriding application.  
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Electronic Registration  
During electronic registration at real.com, you are required to send information about your 
location, e-mail address and connection speed in order to download RealOne Player for Mac. 
This information is sent with relevant system and player version information. The e-mail 
address is used to send updates and special offers via e-mail from RealNetworks, unless you 
opt-out of such e-mail at the time of registration or at a later date. All other information is 
used for aggregate statistical analysis and to provide content that may be of interest to you.  
 
RealOne Player for Macintosh Communications with Streaming Media Servers  
Like previous versions of RealPlayer, RealOne Player for Mac must communicate with 
streaming media servers in order to receive the content sent from the servers. Those 
servers are typically owned and operated by third-party content providers, but these 
servers might also reside at RealNetworks if we are providing hosting services for a content 
provider, or are providing content ourselves. This section describes the information 
transmitted in those communications.  
 
RealNetworks Use of GUIDS in RealPlayer for Mac  
RealOne Player for Mac has unique GUIDs turned off in its default setting  
 
How to Change the Transmission of the RealPlayer for Mac GUID  
To change the transmission of GUIDs, select “RealPlayer menu…Preferences…Internet 
Settings…Send RealOne Player GUID to RealServers” to enable or disable this feature.  
 
Playing content  
Whenever you play a streaming media clip, RealOne Player must send certain anonymous 
information to content broadcasters so that they can send the clip data stream to your 
computer. This data includes your connection speed, player version, language preference, 
Zip Code and country.  
 
Connection Quality Information  
 
By default, RealOne Player for Mac sends anonymous connection quality data to broadcast 
servers to indicate the quality and bandwidth of the stream that you received while playing 
a clip. This helps the content provider understand the quality of the streaming media service 
that they are providing to you. Selecting “RealOne Player menu…Preferences…Internet 
Settings…Send connection-quality data to RealServers” can disable this feature.  
 
Real Services for RealOne Player Mac  
RealOne Player for Mac supports Mac-compatible Real services, specifically Real Home, 
Search, and Radio. Also supported is authentication for Real premium content and services. 
For privacy information related to Real Services and premium content authentication, please 
refer to the RealPlayer (Windows) section listed in the privacy index above.  
 



-23- 

REALPLAYER 8  
 
REALPLAYER 8 CUSTOMER COMMUNICATIONS  
 
RealPlayer allows you to play real-time (streaming) audio, video and multimedia.  
 
StartCenter  
RealPlayer includes a feature called StartCenter that, by default, runs in the Windows 
system tray when RealPlayer is not actively running. StartCenter is used to help improve 
startup time and to manage several automatic Internet communications, including software 
update requests, (AutoUpdate) Channel and Real.com Message Service checks. If you have 
security software, it may alert you to these communications. These communications do not 
indicate a security risk. If you wish to disable the StartCenter feature, you may do so in 
Preferences, however you will not be able to receive automatic notifications when new 
software or media content is available.  
 
Electronic Registration  
During electronic registration, you can optionally send information about your location, e-
mail address and connection speed. This information is sent with relevant system and player 
version information. The email address is used in the event that you elect to receive 
updates and special offers via e-mail from RealNetworks. All other information is used for 
aggregate statistical analysis and to provide content that may be of interest to you. You are 
not required to fill out an electronic registration; choose “Remind me later” during 
registration. A registration reminder will appear three times, after which you may choose to 
permanently disable registration reminders.  
 
Channel Checks  
RealPlayer periodically checks to see if there are new Channels and Channel headlines 
available for your player. At this time, RealPlayer sends the Channel servers information 
about your player version, connection speed (for example, so we can offer broadband users 
high-bandwidth content), country and Zip Code so that we can offer local content, and your 
language preference. For Channel updates or when you add or remove channels, we need to 
send data on the Channels you have installed. Your lists of Channels are not associated with 
you personally. The Channel updating feature can be disabled by selecting View 
Menu…Preferences…Content…Channels and Live Stations…Settings. 
 
Real.com Message Service  
If you have signed up for the Real.com Message Service (News and Entertainment Flashes 
and Real.com Product Flashes), RealPlayer periodically checks to see if there are any new 
messages. During this check and when you choose to personalize your messages, 
RealPlayer sends information on the message categories that you have signed up to receive 
along with information about messages you have already viewed to ensure that only new 
messages are sent. We also send your country, preferred language and relevant system 
information in order to send appropriate messages. The messages to which you have 
subscribed cannot be associated with you individually. The Real.com Message Service can 
be disabled in Preferences.  
 
Finding New Content: Search, Radio Tuner, Message Personalization, and 
Add/Remove Channels 
RealPlayer Search, Radio Tuner, Message Personalization, and Add/Remove Channel pages 
display a Web page when you select these features (Note: if Microsoft Internet Explorer 
version 4 or later is on your computer, these pages are displayed within RealPlayer). When 
these Web pages are displayed, RealPlayer sends relevant system and geographic 
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information to display the correct page. RealNetworks may use browser cookies when these 
pages are displayed in order to store your settings and for aggregate statistical analysis. 
Unless you have previously consented to enable RealNetworks to store your name or e-mail 
in a cookie (for example, if you establish a My Guide account), RealNetworks cannot 
associate your personal information with your use of this feature. You may disable browser 
cookies. However, this will disable Radio Tuner presets and some other customization 
settings. 
 
Technical Support  
If an error occurs when you are using RealPlayer, a dialog box will appear describing the 
error. When you select the “More Info” button on the dialog box to obtain more information 
about the problem, RealPlayer sends relevant system configuration information to help 
RealNetworks technical support diagnose and resolve the problem. This feature can be 
disabled by selecting View menu…Preferences…Support…Send Support Info.  
 
Software Update  
RealPlayer is designed to check for the availability of software updates to ensure that you 
have the latest product improvements. When RealPlayer checks for the availability of a 
software update, basic information about the product version and installed components 
along with geographic information, are sent to RealNetworks to determine whether new free 
software is available for download. For RealPlayer Plus, the software’s serial number is also 
sent during software update. The serial number is used to determine whether the user has 
an active subscription for updates, and whether the software is an authorized copy. We do 
not use the serial number to personally identify our customers. This feature can be disabled 
for 30-day intervals by selecting View menu…Preferences…Upgrade…Turn off notification for 
30 days.  
 
RealPlayer 8 Communications with Streaming Media Servers  
RealPlayer must communicate with streaming media servers in order to receive the content 
sent from the servers. Those servers are typically owned and operated by third-party 
content providers, but these servers might also reside at RealNetworks if we are providing 
hosting services for a content provider, or are providing content ourselves. This section 
describes the information transmitted in those communications. 
 
Playing content  
Whenever you play a streaming media clip, RealPlayer must send information to content 
broadcasters so that they can send the clip data stream to your computer. This data 
includes your connection speed, player version, language preference, Zip Code and country. 
This communication cannot be disabled; however, you may opt to not identify your Zip Code 
during electronic registration, or if you have already submitted your Zip Code, you can re-
register the product from the Help menu and omit this field to delete it from your product 
and RealNetworks records.  
 
Zip Code Information  
Upon product registration, we may ask users to supply us with the Zip Code where their 
RealPlayer is used. The Zip Code is used by RealNetworks to improve traffic routing and 
reduce network congestion by finding servers that are located closer to your Zip Code 
address. RealNetworks may also use the Zip Code to offer content and instructions that are 
most appropriate for your language and region.  
 
For more information about enabling or disabling GUIDs with streaming media servers, 
please go to http://www.real.com/products/player/g2/rsdata.html#guid  
 

http://www.real.com/products/player/g2/rsdata.html
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Connection Quality Information  
By default, RealPlayer sends anonymous connection quality data to broadcast servers to 
indicate the quality and bandwidth of the stream that you received while playing a clip. This 
helps the content provider understand the quality of the streaming media service that they 
are providing to you. This feature can be disabled by selecting View 
menu…Preferences…Support…Send connection-quality data to RealServers.  
 
You may disable RealPlayer 8 cookies by selecting View 
menu…Preferences…Support…Enable Cookies. 
 
REALONE SUPERPASS 
 
Member Verification  
 
As a RealOne SuperPass Member, you enjoy an exclusive combination of premier audio and 
video content, software, and services. Because these benefits are available only to active 
members, we need to personally identify you with your member ID whenever you attempt 
to play or download RealOne SuperPass content or software in order to verify that you have 
rights to access these exclusive benefits. We keep a record in your member account of any 
Real software that you download or RealOne SuperPass services for which you sign up so 
that we can provide you customer service and technical support and in order to prevent 
fraud. However, we do not store information about the RealOne SuperPass content you play 
with your personal account information.  
 
How Does RealOne SuperPass Member Verification Work?  
By default, RealNetworks places a cookie on your computer when you first log in to access 
RealOne SuperPass content, software, or services. This optional cookie contains a member 
identification number that allows us to recognize you when you attempt to access RealOne 
SuperPass benefits so that you don’t need to enter your e-mail name and password each 
time. This cookie is placed in your Web browser (so that you can access RealOne SuperPass 
Web pages) and in your RealPlayer (so that you can play RealOne SuperPass streaming 
audio and video). This cookie is only transmitted to RealNetworks, and the contents are 
never shared with outside companies.  
 
Opting Out of RealOne SuperPass Cookies  
You may elect not to have your user ID stored in a Web browser or RealPlayer cookie by 
adjusting your security settings in your browser. However, by doing so you will be required 
to re-enter your e-mail address and password each time that you would like to access 
RealOne SuperPass exclusive content, software, or services. 
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REALJUKEBOX 2  
 
REALJUKEBOX 2 CUSTOMER COMMUNICATIONS  
 
RealJukebox is an application that allows you to download, play, record and manage music 
either online or using CDs.  
 
StartCenter  
RealJukebox includes a feature called StartCenter that, by default, runs in the Windows 
system tray when RealJukebox is not actively running. StartCenter is used to help improve 
startup time and to manage several automatic Internet communications, including software 
update requests (AutoUpdate). If you have security software, it may alert you to these 
communications. These communications do not indicate a security risk. If you wish to 
disable the StartCenter feature, you may do so in Preferences, however you will not be able 
to receive automatic notifications when new software is available.  
 
Electronic Registration  
During electronic registration, you can optionally send information about your location, e-
mail address, and connection speed. This information is sent with relevant system and 
player version information. The e-mail is used in the event that you elect to receive updates 
and special offers via e-mail from RealNetworks. The other information is used for 
aggregate statistical analysis and to provide content that may be of interest to you. You are 
not required to fill out an electronic registration; choose “Remind me to register later” 
during registration. A registration reminder will appear three times, after which you may 
choose to permanently disable registration reminders.  
 
CD Lookup  
The CD Lookup feature allows you to automatically obtain detailed information (Artist, song 
track titles, genre) for the CDs you use with RealJukebox. During a request for CD 
information RealJukebox sends the Table of Contents Code from the CD to a database 
service in order to look up the CD information. RealNetworks does not store any personally 
identifiable information about the songs or albums you record with RealJukebox. This 
feature can be disabled by selecting Tools…Preferences…Internet…Options…Automatic CD 
Lookup Information. However, you will not be able to automatically obtain the detailed CD 
information if the feature is disabled. If you record CDs offline, CD Table of Contents (TOC) 
information will be sent to RealNetworks when you establish an online connection. Again, 
you can disable this feature per the instructions noted above.  
 
Finding New Content: Search and Radio Tuner  
RealJukebox Search and Radio Tuner pages use Microsoft Internet Explorer (IE) to display a 
Web page in RealJukebox when you select these features. When these Web pages are 
displayed, RealJukebox sends relevant system and geographic information to display the 
correct page. RealNetworks may use IE cookies when these pages are displayed in order to 
store your settings and for aggregate statistical analysis. Unless you have previously 
consented to enable RealNetworks to store your name or e-mail in a cookie (for example, if 
you establish a My Guide account), RealNetworks cannot associate your personal 
information with your use of these features. You may disable IE cookies in Internet 
Explorer. However, this will disable Radio Tuner presets and some other customization 
settings.  
 
Artist Guide  
RealJukebox allows you to automatically look up artist biographies, album art and 
information, concert dates, etc. through the Artist Guide (Track Info) feature. When you use 
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Artist Guide, information identifying the currently playing track is transmitted to Real.com 
and content partners so that we can display the appropriate artist information. The Artist 
Guide feature can be disabled in Tools…Preferences…Internet…Options. When enabled, the 
Artist Guide is displayed using Internet Explorer inside RealJukebox. RealNetworks may use 
IE cookies to store your settings, recommend content that may be of interest, and for 
aggregate statistical analysis. Unless you have previously consented to enable RealNetworks 
to store your name or e-mail in a cookie (for example, if you establish a My Guide account), 
RealNetworks cannot associate your personal information with your use of this feature. You 
may disable IE cookies in Internet Explorer.  
 
Music Guide  
When RealJukebox is started while you are connected to the Internet, RealJukebox by 
default checks whether updates are available for the Music Guide page. The information that 
may be updated includes: Music Guide page, list of supported hardware devices, 
RealJukebox Home Page layout, promotion button, and default (offline) pages for the 
Search, Radio Tuner, and Music Guide features. During this check, RealJukebox sends 
information about the RealJukebox version you are running. RealNetworks does not collect 
directly identifiable personal information during this communication. Automatic Updating of 
Music Guide can be disabled by selecting Tools…Preferences…Internet…Options…Automatic 
Music Guide updates.  
 
Technical Support  
If an error occurs when you are using RealJukebox, a dialog box will appear describing the 
error. When you select the “More Info” button on the dialog box to obtain more information 
about the problem, RealJukebox sends relevant system configuration information to help 
RealNetworks technical support diagnose and resolve the problem. This feature can be 
disabled by selecting Tools…Preferences…Internet…Options…Faster access to Technical 
Support. Software Updates RealJukebox is designed to check for the availability of software 
updates to ensure that you have the latest product improvements. When RealJukebox 
checks for the availability of a software update, basic information about the product version 
and installed components are anonymously sent to RealNetworks to determine whether new 
free software is available for download. For RealJukebox Plus, the software’s serial number 
is also sent during software update. The serial number is used to determine whether the 
user has an active subscription for updates, and whether the software is an authorized copy. 
We do not use the serial number to personally identify our customers. This feature can be 
disabled for 30-day intervals by selecting Tools…Preferences…Internet…Options…Automatic 
Update Notification.  
 


